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Introduction

In this document, Paper Prototype Testing with Morae, walk through how to use TechSmith’s Morae to
conduct a usability test with a paper prototype.

This document is intended for people that are already familiar with the concept of usability testing.

Usability Testing Basics

If you're new to usability testing, start with Usability Testing Basics which explains the basics of usability
testing, including information about how to figure out what to test, when to test, and how to test. Usability
Testing Basics is available on the Morae Resource CD and in the Morae Learning Center
(http://www.techsmith.com/learn/morae/default.asp).
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Paper Prototype Testing with Morae

Morae is the premier software for deeply understanding customer experiences...and sharing those insights
clearly and powerfully. From usability testing to focus groups and beyond, Morae helps you transform designs
and marketing to make things people love.

For a paper prototype test, Morae can record from one or two cameras. With two cameras, you can record
close-up video of the prototype, along with camera video of the user.

We will walk you through completing a test with Morae, including:

P Set Up the Test

# Record and Log Test Sessions

# Analyze and Present Findings

# How to Retrieve Your Key Measures from Morae

The document also contains the following appendices:

B Appendix A: User Research Request
# Appendix B: Test Protocol Document
# Appendix C: Example Usability Test Report
#  Appendix D: Usability Test Checklist

Paper Prototype Testing Considerations

Using paper mock ups, sketches, or wire frames of a system, participants are asked to explain how they
would accomplish real-world tasks using prototype. This method is best used early in the design process to
explore the effectiveness of a conceptual model, navigation, workflow, and other high-level aspects of the design and
to provide design direction.

Because the paper prototype and the participant’s interactions with it with it will be recorded using a camera,
consider what cameras, lighting, camera locations, and mounting hardware will be needed to record the
activity.

Because screen recording data will not be available, prepare your markers carefully to ensure that observers
or the person logging on the recording computer will note events such as:

B Task start and end times

The actions the participant takes (buttons clicked, menu items chosen)
When a mistake or error is made

Comments and quotes of the participants

¥y ¥ ¥V ¥

Observations of facial expressions and body language, etc.

Interaction with the participant during a paper-prototype test will need to be high-level, as the interaction of the
prototype will need to be described to the participant by the facilitator. Because of this, paper prototype tests
should be conducted face-to-face (not remotely).

Procedure

The facilitator, or an assistant, acts as the “computer,” responding with another paper “screen” or explaining
the interactions of the system if it were fully functional when the participant performs an action.
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The person acting as the computer should think of themselves as a machine that can only react to human
actions or input, process information, and produce corresponding output. This means that the facilitator of the
tests must elicit active responses from the participant that the “computer” can respond to. For example, a
participant may want to say, “l would go here” and it is the facilitator’s job to inquire what navigation button the
participant would click on (by asking non-leading question according to the best practices of any usability test).

In this type of testing, the paper prototype and the participant’s interactions with it will be recorded using a
camera. A second camera can also be used to record participant’s face with a Web cam via Picture-in-Picture
mode.

Use the default configuration provided for paper prototype testing in Morae to record the test. Because there
will be no screen recording used, the recording computer can also be used to log test data during the test by
the facilitator or an assistant; consider having the facilitator log the test on the recording computer. Remember
you may need to flip your camera while recording to make the prototype view properly in the recording.

= Cover your paper prototype with protective plastic and bring dry-erase markers. If your participant
doesn’t see something they need or has to enter or input information, have him or her draw or write on
the prototype. This can be recorded by the camera (you may want to take a close-up shot of the
prototype with drawing on it) and the markings wiped-off for the next participant.

Snyder, C. (2003). Paper Prototyping. San Francisco, California, USA: Morgan Kaufmann.
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Set Up the Test

After you figure out what to test and the goals for testing, use the steps in this section to set up the test in
Morae Recorder. For more information on usability test planning, see Usability Testing Basics, available on
the Morae Resource CD and in the Morae Learning Center.

Morae
Recorder

1. Create a Study Configuration
2. Define the Scenario

. Define Tasks

. Define Markers

. Define Surveys

. Save Study Details

. Configure Recording Details
. Complete Test Set Up

To set up a test in Recorder:

N O |Jo | W

A’ This document walks through this process at a high level. You can find more information on the full
procedures and options in the help included in the Morae components or find both video and written
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.

1. Create a Study Configuration

A study is a group of test sessions where participants complete the same tasks. In Morae, a study
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and
surveys.

You use the same study configuration to record each of the test sessions. Only recordings with the same
study configuration can be later searched and graphed together in Morae Manager.

Morae Recorder includes template study configurations to help you define study configurations for different
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured
Recording Details which define how to record the session.
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When you open Recorder, create a new study configuration based on Paper Prototype Study. When you
click OK, the template study configuration opens in Recorder.

Welcome to Morae Recorder @

To record, you must create or open a study configuration.
Study configuration

The study configuration defines the markers, tasks, and surveys
for your study.

D (3) Create a new study configuration based on:

I aper Prototype Stud v

Default Study
Focus Group

Hardware or Mabile Device Stud
Paper Prototype Stud )1P

— Software or Web Usability Study
L:; (Olunmoderated Usability Study

2. Define the Scenario

A scenario gives the participant the background to complete the tasks. It tells them why they are doing the
tasks and any introductory information they may need to complete the task.

The scenario should be realistic and allow the participant to relate to the situation. For more on how to create
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning
Center.

For example, to find out how users interact with your company web site, the scenario may be:
You will perform up to 4 different tasks using a paper prototype of a software application.

You have just purchased new software and you want to figure out how to get started. Follow the
instructions for each task and then perform the task as you would if you were actually doing this task
for yourself.

Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations,
and reactions.

Do you have any questions?
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Scenario in Morae Configuration

@ Recorder > Modify Study Details button > Description tab

Enter the scenario into the Study instructions field.

Study Details

Description | Task Definitions | Marker Definitions | Survey Definitions |

Enter a name, description and participant instructions For the study.

Study name: | Paper Prototype Study

Study description: Use to record low fidelity prototypes that can't be
displayed on the computer. You can use up to two
cameras. Point the primary camera at the paper
prototype, and the picture-in-picture camera at the
participant.

=

| Study instructions:  lyau will perform up to 4 different tasks using a paper A
prototype of a software application. =

‘You have just purchased new software and you want
to figure out how to get started. Follow the
instructions for each task and then perform the task as
vou would if you were actually doing this task for
vourself,

Please talk out loud while you work, and keep arunning
dialog of your thoughts, actions, expectations, and

ireactions.
™ - - B -

PR %

Morae Scenario Tips

#  Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test
Protocol Document).

#  To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See
AutoPilot in the Morae Recorder help for more information.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Description >
Study Instructions.
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3. Define Tasks

The tasks should relate to real-life actions that fit the scenario. For more on how to create a scenario, see
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center.

For example, if we use the example scenario of “You have just purchased new software and you want to
figure out how to get started,” our first task is for the participant to explain his or her first impressions of the
prototype.

Tasks in Morae Configuration

d Recorder > Modify Study Details button > Task Definitions tab

For each task, enter a name, description, and instructions for the participant.

Study Details

| Description | Task Definitions i-Marker Definitions ilgurvey Definitions |

Define tasks to log during sessions.

Name Description Ir
Taski |Firstimpressionsof theprototype
Task 2 How to backup software D
Task 3 ~ Stuck, how would you find help D
Task 4 SR > !
TaskS [ Tasknames, descriptions, and scores are M

available to the task logger in Recorder or
Observer and in the task information in

Success score
Success score applies to all

Definition Scale 5 Add
Completed with ease 0

Completed with difficulty 1 7 Edit
Failed to complete 2 e —

&  Remove

Success score is a standard metric used to
analyze usability tests. You can create a task
success score graph in Manager to automatically
calculate and visually display the completion rate.

Start Sc

= Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test
Protocol Document) on the Task pages. Each task should be on a separate page so the participant
can only see one task at a time.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks.

Page 10


http://www.techsmith.com/learn/morae/default.asp

4. Define Markers

After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure
out what kinds of actions you want to define marker for because, by flagging important points during recording,
you can save time when you later analyze the results.

For example, mark:

Participant actions

Participant comments and questions

Participant frustration

Areas where a participant gets stuck

Application or web site design issues

Observations about how the participant performs a task

Interesting comments or actions to include in a highlight video

Moments when participant’s access Help, want to contact customer service or technical support

¥ ¥V ¥ ¥ ¥V ¥ ¥ V¥

You can also add notes to provide additional details for each marker. All the markers and notes are
synchronized with the video and saved in the recording of each test session.

Morae also includes the ability to score markers, for example 0 (severe) to 2( minor). Manager can
automatically calculate the average severity of the errors.

Markers in Morae Configuration

&3 Recorder > Modify Study Details button > Marker Definitions tab

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color.
Each study configuration template includes a default set of markers. The Hardware or Mobile Device Study
template includes the following markers:

’ Q — Quote/comment A d X - Error

’ ’ O- Observation

H — User needs help

P - Participant prompted 0 V - Video clip

Use the provided default markers, modify the markers, or create new markers that match the goals of your
study or identify specific things you want observers to watch for during a session.

Morae Marker Tips

B  There is no correct number of markers. The object of logging markers during a test is to make it easier to
analyze the test results.

# If you have specific things you want to look for in a test, create a marker for that action, problem, etc.

B Later when you analyze your sessions in Manager, markers help you sift through data and focus on what
you want to analyze. For example, viewing all the Help requested markers may reveal an error where
people are really struggling.

#  When you are ready to create video clips or a presentation for stakeholders, you save time by quickly
going to the moments during the session that you marked to include in the highlight video.
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For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers.

5. Define Surveys

With surveys, you can collect information directly from the participants.

To collect a participant’s survey responses, you can either ask the questions verbally and type the responses
into the survey, have the participant take the survey on the computer running Recorder, or use the Morae
Add-In for Word to print the surveys for the participant to fill in on paper.

After you import recordings into Manager, you can view and compare responses, create graphs based on the
surveys, and export results, including any freeform answers.

Morae can deliver multiple surveys to participants during a session. For example, before the test, after each
task, and after the test.

The template study configuration includes surveys. Use or edit the surveys provided or create your own
surveys.

Surveys in Morae Configuration

Recorder > Modify Study Details button > Survey Definitions tab

Create and associate surveys with session events, such as the end of a task.

| Description | Task Definktions | Marker Definitions | Survey Defintions

Define surveys for this study. Assodate surveys with session events, such as the end of a task,

Name Associate With o~ Add> N ‘l
Task 2 Completion Survey  End of Task 2 g [

Task 3 Completion Survey  End of Task 3 =
Task 4 Completion Survey  End of Task 4
Task S Completion Survey  End of Task S
SUS End of recording

Survey Definition

Survey detalls
Survey name: Participant instructions:
Demographic Survey Please answer the following question
Associate with:
Beginning of recording v

Morae includes . Survey quastions
System Usability -

Scale (SUS) standard ® Custom 0

satisfaction questions
that you can use once Quastion Type
per study recording Flease indicate your gander: Select one 5
! Flease indicate your age range: Select ons &
' Flaase rate your experience with the Internet Scale
How many hours & week do you spend on the Internet 28 work? Select (
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Morae Survey Tips

B Associate a survey with the beginning of recording, end of recording, or the end of each task.
B+ By associating a survey with a session event, it is “linked” to that event.
Morae readies the survey associated with the current session event.

B  Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test
Protocol Document).
B  The System Usability Scale (SUS) is freely available for use in usability assessment and has been used

for a variety of research projects; the only prerequisite for its use is that any published report must
acknowledge the source of the measure. If you use the SUS, add the following to your report:

“SUS was developed as part of the usability engineering program in integrated office systems
development at Digital Equipment Co Ltd., Reading, United Kingdom.”

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys.

6. Save Study Details

La File > Save Study Configuration or click the Save Configuration icon.

Study Details must be the same for all recordings in a study and include the items you have just defined:

B Study name, description, and instructions
B  Tasks definitions and instructions

B+  Marker definitions and instructions

B Survey definitions and associations

By saving the study configuration, and reusing that configuration, all recordings in a study have the same
configuration and can be imported into the same study in Manager.

7. Configure Recording Details

Recording Details included in Morae study configurations define how to record the session, including the
following:

# File saving and processing options

Video sources

What data to capture

Who logs tasks

How to start and end test recordings

¥V ¥ V¥
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Recording Details in Morae Configuration

&8 Recorder > Recording Details button

The Recording Details of the template study configuration allow you to immediately conduct a recording.
The Recording Details for the Paper Prototype Study template include:

#  Prompt for file saving details when recording stops

Record from a camera and include a Picture-in-Picture video from a second camera
Log tasks with the computer running Recorder

Start and stop recordings manually with Recorder

Allow Observers

¥y ¥V ¥V V¥

Morae Recording Details Tips

# Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected
sources are correct before recording.

# If you change any Recording Details settings, the rest of the settings update to provide a valid or
recommended configuration, if needed.

# Recording Details are saved as part of the study configuration. While the Study Details must be the same
for all recordings in a study, the Recording Details can vary in each recording.

For more information, in the Morae Recorder Help, see Define Recording Details.

8. Complete Test Set Up

Study configuration is now complete. Here are the final things to do before you start testing.

# Create Test Protocol
# Finalize Morae Recorder Setup

Create Test Protocol

The test protocol is a document of everything needed for a test. There is an example protocol document in
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.

B Test Session Setup Checklist

Release Form

Facilitator Script

Participant Instructions and Surveys
Assemble Participant Paperwork (Optional)
Email Invitations for Observers

¥V ¥V ¥ ¥V V¥
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Test Session Setup Checklist

Verify the test setup is the same at the beginning of each test. A test setup checklist makes it easier to go
from one test to the next as quickly as possible and make sure you do not miss anything.

Make a list of all the things you need to do between tests and include it in test protocol document, such as:

v

Erasing any written items on the prototype.

B Clear the test area of any open documents, written notes, etc.
B Prepare participant forms (release form, surveys, etc.)

B Verify the cameras, camera angles, and lighting.

Release Form

A release form gives permission to record the test. Morae records the participant’s interactions with the
hardware or mobile device with video and audio.

If permission to record is denied, you may still conduct the test and take notes to use in reporting result, but
you must not record the test session.

If the contents of your test require the participant to keep session and product information confidential, include
a non-disclosure agreement to your form.

The example test protocol includes a sample release form that includes a non-disclosure agreement.

Facilitator Script

The facilitator script helps to explain the test session to the participant. The facilitator reads through the script
at the beginning of each test session to ensure the participant understands what to expect during the test.

Participant Instructions and Surveys

Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the
study configuration in the add-in and drag the study and task instructions along with the surveys into the
protocol.

— R

;lv, eroelad:?ane 'x:‘

g~ |
Morse Project ‘ 1
Example Project v -&owse
Survey

|
|
|

1. Please indicate your gender: ‘
( ) Female
[ )Male

2. Please indicate your age range:

()18-25

{ 2635 i
(13650 (4}
{ )51.85 [
[ )65+ 4 L

3. Please rate your experience with the Internet )
Very New 1 2 3 4 S Very Expenenced Ihi

4. How many hours a week do you spend on the Internet at work?

For more information, click the help button in the Morae Add-In for Word.

Page 15



Assemble Participant Paperwork (Optional)
Once you finish the protocol document, you need to assemble any paperwork needed for a test.

If you are printing paperwork, each participant needs a copy of the following:

v

Release form

B  Background questionnaire

B Scenario/session instructions
#  Tasks

For the facilitator, print out a copy of the entire protocol. In addition to the participant items listed above, the
facilitator protocol includes the following:

B+  Title page

Session setup checklist

Participant paperwork coversheet

Facilitator script

Task success paths (the best way or ways to complete a task)

List of debrief questions (follow up questions for the end of the test)

¥ ¥V ¥V ¥V V¥

See the example test protocol in Appendix B: Test Protocol Document for an example of complete protocol.

Email Invitations for Observers

Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people
that observe the test can connect to the session, send an email to each observer with the following
information:

# Name of test

#  Date of test

B  Time of test

# |IP address or name of Recorder computer

= You may also want to include a list of the test tasks and markers to let the observers understand what
they should watch for during the test.

Finalize Morae Recorder Setup

Prior to a Morae test, complete the following tasks:

# Complete the Pre-recording Checklist
P Run aPilot Test before Recording
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Complete the Pre-recording Checklist

The following checklist describes critical points that reduce the technical issues you may encounter and
improve Morae’s overall performance.

Step

Verify the system
requirements

Description

Verify your system meets the recommended specifications to get the most
efficient performance from Morae. For more information, see Morae System
Requirements in the Morae Recorder Help.

Verify you have
enough hard drive
space

Recording file sizes may be approximately 10-15 MB per minute, but the actual
size varies depending on many factors. You should have extra space available for
the best performance during recording.

As a general rule, maintain 5—-10 GB of extra hard drive space as a buffer beyond
what your Morae recording files use.

A’ We recommend initially saving your recordings to a local hard drive to
eliminate the chance of data loss that can occur when saving over a network
or to an external device. After the file is saved, you can copy the recording file
to an external device.

Test your setup and
scenario

Test your setup before the actual recording session to resolve any possible
complications (such as firewalls blocking Observer(s) from connecting, etc.).

We recommend running a pilot recording for a short period of time to test
Recorder’s start and stop options and to verify Observer(s) can connect. For more
information, see Run a Pilot Test before Recording.

A’ In addition, use the Test Recording option in Recorder to create a 15 second
recording to verify the screen, camera, and audio streams are being recorded

properly.

Verify Network
Settings

If Observer and Recorder are on the same Intranet, you do not need to disable
firewalls.

If they are not, verify that you either disabled any firewalls running on the Recorder
or configured the firewalls to open the communication ports. See your network
administrator for assistance.

There are no firewall adjustments necessary on the Observer side.

Open the study
configuration in
Recorder

Open the saved study configuration in Recorder.
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Run a Pilot Test before Recording

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot
recording helps you work out any network connectivity issues and test your automated start and stop options,
if applicable. Follow these steps to run a pilot test:

Step ‘ Notes
1. Open a study configuration. In Recorder, open the study configuration (.mrcfg) for this study.
Start Recorder. Click the Start button to start Recorder manually.
3. Connect Observers to Connect one or more Observers during the pilot test. Verify that you
Recorder. can successfully connect each to Recorder.
4. Complete a test task. Run through one of the tasks. To test the logging functionality of

Observer, have a team member practice setting markers while you
complete the task.

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button in
Recorder or use the keyboard shortcut <Ctrl + Alt + Shift + F9>,

6. Import the recording and run a Save the test recording file and import it into a project in Manager. In
search. Manager, verify the audio and video recorded correctly. Use the
Search to verify markers were captured. See Analyze and Present

Findings for more information on how to do this.
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Record and Log Test Sessions

In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae
Recorder and Observer. Included in the section are the following:

# Log Tasks on Recorder

Observers and Logging

Start and Stop the Recording

Log the Sessions

Send the Surveys

Save the Recording

¥ ¥V ¥ ¥V V¥

Log Tasks on Recorder

When you record from one or two cameras with Recorder, you can log tasks and notes right on the computer
running Recorder. This is the default task logger setting for camera only recordings.

Observers and Logging

Morae Observer connects to Recorder over a network and displays the full participant’s experience, including
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores,
and text notes that are sent back to the Recorder and saved with the recording file.

Observers

Parfiu'fenf

B

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically
create graphs, calculate marker scores, and more.

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not
see the participant interaction until recording begins.
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Benefits of Observer

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the
following benefits:

B Stakeholders can connect to watch live sessions without the need be in the room with the participant or
an observation room. With Observer, stakeholders can connect from anywhere on the network.
= Anyone logged into an Observer computer can add markers during recording complete with text notes.

# Morae automatically collects and compiles everyone’s notes. The recordings contain the markers and
notes logged by all Observers.

B  Observer automatically saves and indexes the markers and tasks with the accompanying video and audio
streams.

#  You can save a copy of the camera video, screen video, and audio streams as a WMV file for immediate
playback or to share with stakeholders.

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to
Recorder.

Start and Stop the Recording

The default way to start and stop recordings is to manually start and stop Recorder using the following
buttons:

@

Start Stop

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your
equipment and participant set up.

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start
Settings and Define Recording Details > Recording Stop Settings.

Log the Sessions

Once recording starts, the facilitator prompts the participant to begin the test.

The person working on the computer running Recorder along with each person using Observer can log
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder
is designated as the task logger logs tasks and task scores.

With both Recorder and Observer, you can save a copy of your markers and notes. Observers can also save
a copy of the recording as a WMV file for immediate viewing.

. A AN -

T .\_/'.__\-'J/- o et T — PR T R v '\'V_._v_/.'- LS et e J.,"-_,
Survey: Survey v [Send Survey| =3
= Note Marker T Score Task Time
(D rosearse) | @ erdrekianin | we
L B Task wes suxccessfl Task | 00028
Logas: |Task3 v B roskwes sxcessfd Tazk 1 00042
v Task 3 0048
- - o Restart | @ Mo sad he this was very confusing, Q-Quotajcomment Tack 00141
- 1 ,41 Q© Coel Q[mwgt_ufgg_m _ W-User reeds help Task 3 ol
Recordrg time = 000C-30 Task: Task 3 Task ogger: Tiany L) Connection J Recordeg
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At the end of a session, the tasks and task scores are saved with the recording. You can view the
synchronized video, audio, and notes for each marker later when you import the recording into Manager.

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager.
There should be no need to review entire recordings if you use Manager’s powerful search and graphing
features to quickly analyze the recordings.

The components used when logging in Recorder and Observer are:

Marker Definitions
Click a Marker Type to

View main camera video.

PiP Window
View session PiP video.
Hear participant
- thoughts and comments.

: Survey [in progress) Cm .
(@ rumiren | [@ earesinn || . I e T
R Tm‘ ‘:1.30’.,,“! QQuokafcomment Task 1 00602
00:01:18 58

UL, & o Log

Log markers and take notes. Log
task start and end, if applicable.

[Rocorong tane = 000714

For more information, in Morae Observer Help, see Log a Session.
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Send the Surveys

Open surveys on the computer running Recorder anytime during the session. When the surveys open, you

can ask the participants the questions and fill out the surveys, let the participant fill out the surveys on the

computer running Recorder, or use the Morae Add-In for Word to print the surveys for the participant to fill in

on paper.
The person logging on the computer running Recorder and all Observers can access and deliver surveys.

# In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>.
# In Recorder or Observer, select and open surveys from the log.

Survey: Task 2 Completion Survey Y\

Task 1 Completion Survey (done] .
m L Task 2 Completion Surve 5

Task 3 Completion Survey

Save the Recording

By default, when recording stops, you are prompted for file details. Enter a name and description for the
recording. If you want to start another recording right away, in Recording Details, choose to defer the
processing of the recording. You can later batch process recordings.

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details >
Processing.

V' You cannot save a recording without a name. You can lose the data from a recording if the test
participant, or anyone else, closes the dialog prompting for these details after the recording stops.

Analyze and Present Findings

In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and

create presentation materials for the test findings.

Included in the section are the following:
1. Import Recordings
2. Edit Recordings

3. Analyze Recordings

4. Graph
5. Create Highlight Clips

6. Create a Report
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1. Import Recordings

To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the
recordings and studies in Manager.

You can have multiple studies in a single project. The following are possible reasons to have multiple studies
in a single Morae project:

#  You conduct the same test on different iterations of a product.
#  You conduct various tests on the same product.
B You want to separate your studies by the experience level of participants.

You can import a single recording into multiple projects. When you import a recording into a project, the
original recording is not touched. A copy of the recording in imported into the project. Any changes you make
to this copy do not affect the original recording.

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf)
into a project.

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create
and Modify a Project > Create a New Project.

2. Edit Recordings

View and edit the imported recordings in the Analyze Tab. In Manager :

v

Review the main camera video automatically synchronized with the Picture-in-Picture video and audio.
B  Create additional or edit the logged tasks, markers, notes, and scores.

B Search across recordings in a study for specific markers..

B  View and edit survey answers.

For information, in the Morae Manager Help, see Analyze.

3. Analyze Recordings

For information on what kinds of things to look for in the recordings, see How to Retrieve Your Key
Measures from Morae.

Manager’s Search allows you to quickly create custom searches to look for markers and tasks.

You can use the pre-defined search profiles, define a new search, or create and save your own search
profiles.
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06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc

Search for:

[[] Screen Text

] window/Dialog Events
Markers (Specific markers of mark... ([ Modfi 2]
] Mouse Clicks 7 }
] uservue Chat

(7] Keystrokes

[C] web Page Changes

Y
In all applications ol Markers

Search for markers that meet the following criteria.
O Al markers

(%) Specific markers
[V] Marker type

[] E-End task ~ | Select Al ]
Clear Al

[¥] H- User nesds help

[7] © - Observation 3
[[] e - Participant prompted

[J Q- Quotejcomment

[[] s-start task

DV-%OCb v

[V]Marker score

[] score not set | Select Al ]
Severe (0)
] Medum (1) |  Clear Al l

Click to save the current search as
a profile.

Click to change the search.

~Search profile : ~View —
[Custom search v jH‘ lm ’
/  Elapsed ... Recording Task Event Details Notes Score

0:02:02.08 Participant 2 Marker H (User needs help)  Issues with the phone locki... 2 - Minor
0:03:12.00 Participant 1 Task2 Marker  H(User needs help) Requests help from faciltat... 1 - Medium
0:03:28.15 Participant 3 Task2  Marker H (User needs help)  Locked out of phone 0 - Severe
0:03:28.15 Participant 3 Task2  Marker H (User needs help)  Runs into trouble with the .., Score not set
0:04:47.32 Participant 2 Marker H {User needs help)  Can't figure out the setting...

2 = Minor
0:05:26.14 Participant 1 Task3  Marker H (User needs help) Wants to call customer sup... 1 - Medium
0:07:32.06 Paﬁl:i Task4  Marker H (User needs help)  Can't figure out menus, As... 1 - Medium

< Results include all occurances
Total Even from all recordings in the study. Selected Duration: Not applicable

For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings.
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4. Graph Data, Tasks, Markers, and Surveys

Instead of manually calculating data and building graphs, Morae creates graphs to help you share results
faster, without manual calculations and scrubbing of data.

Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight
videos. Highlight videos can be more powerful with graphs included to support the video clips.

Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format
(CIF) standard — effectiveness, efficiency, and satisfaction:

B Measure effectiveness with error rate and completion rate graphs

B  Measure efficiency with a time on task graph

B Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to

participants at the end of the recording
Example Uses of Graphs

Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why
you might want to use these graphs.

SUS Survey Use this graph to measure satisfaction from a
Graph @{ = - @{ System Usability Scale (SUS) surve)_/.
"..QW&@*‘ 8 SUS scores can range from 0 (very little
K}//' \ :x satisfaction) to 100 (very high satisfaction).
Survey SUS Survey
Analysis Calculation

Time on Task
Graph

v

Use this graph to measure efficiency.

Efficiency is usually measured by determining how
quickly participants are able to complete scenarios
or tasks.

Participants may be able to successfully complete
an activity, but they take a long time.

Task Analysis

Time on Task

Task Score
Graph

v

v

Use this graph to measure effectiveness by
reviewing the completion rates for tasks.
Effectiveness is a way of trying to understand
better how successfully users will be able to use a
site or software. This is usually measured by
determining how many scenarios or tasks
participants are able to complete.

Task Analysis

Task Score

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph >
Graph Analysis Examples.
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5. Create Highlight Clips

When you are ready to organize the results of your analysis into a highlight video for presentation, select
Manager’s Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort clips and graphs and
assemble them into a video presentation.

In the Present tab, assemble the important video clips, graphs and tasks into a highlight video to share with
stakeholders. Include just the participant’s screen and audio in the highlight video or add a Picture-in-Picture
(PiP) window showing the participant’s facial expressions. The highlight video can be produced in AVI, WMV,
or MPEG-4 format.

Clip Bin
Store and organize video clips,
graphs, and title clips from the

Present Tab Toolbar

Player Window
View the camera video,
o including the PiP.

Project Pane
Organize studies
and recordings.

& Gremts YormGow  Poowsar,

2 Morae Examle Project Usabiy Tet
< > Title Chps
|M-m o v 2 Timeline
(5 s 0 Navigate through
Details Pane el | iovwy.. o recordings, tasks,
. £ o
View details about § e 0
topent |_Faper vy e

the selected item.

Usabay Test Hghagne: - | Moknteenng Fecus

Storyboard
Assemble and produce
highlight videos.
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After you have your highlight clips together in the storyboard, click the Produce Highlight Video button and
select the Produce to PowerPoint option to produce the videos and send them into a PowerPoint
presentation.

A Example Project.mpr - Morae Manager
File Edit Create Play View Help

| I @ - I\“V-;.;‘ -;-&‘5

Production Wizard

—

Welcome to the Morae Production Wizard! S
Select one of the ways in which to produce your highlight videa. 1[ "’\5 )

Production Type

() Produce ta file !
Produces the highlight video and saves it to disk. Vi

(%) Produce to PowerPoint

Produces the highlight video and exports it to PowerPoint.
You must have Microsoft PowerPoint installed.

"\...‘\\\' B e ORGP PT SRR F M*AW‘M

For more information on creating highlight clips and options for exporting other data from Manager, in the
Morae Manager Help, see Present.
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6. Create a Report

Appendix C: Example Usability Test Report is an example report showing where you can place graphs,
data tables, and other information generated by Morae.

Use the Morae Add-In for Word to put items created in Manager, including graphs, graph tables, tasks, and
surveys into the report. Open the project file in the add-in and drag the items into the document.

L’@ d92-0 ¢ Document! ~ Microsoft Word Table Toats -2 X
: Home  fmsert  Pageimout  References  Madings  Renew  View  Adadnr  Devgn  Lagout w
Header Row Fust Column = = o SAsheding - -”“1 37|
- - -
Tern Row Lant Column - = s [lBorsen « B ] B

Draw  Erater
aPemoleT  Taple
Table Styles Diaw Sorders

V. Sanded Rows ¥ Eanded Codumng

Table Stple Opticoa

E ;E ’ e X 2 \ 3 ' <3 Morae Task Pane
: Motan Profect .
Moxse3 Srmak Pech. | ¥
Marker Coumt s
s
iz h :
=
e B

JJuk Detinisons

Pagelotl  Words 106 O Eaginh (US)

For more information on how to use the Morae Add-In for Word, click the help button in the Morae Add-In for
Word.
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How to Retrieve Key Measures from

Morae

What was Measured

How To Retrieve the Measure in Morae

Time on Task

The length of time it takes the
participant to complete a task.

May be averaged for all
participants and can be compared
between tests.

If this has not already been completed, set the start
and end markers at the beginning and end of each
task and create a task on the Morae Manager
timeline.

When all tasks are created, choose the Time on
Task Graph in the Graph tab to see the results.
Results may be averaged or viewed by task or by
participant.

Task Success

Whether or not the participant was
successful and to what degree:
completed with ease, completed
with difficulty, failed to complete.

Select each task’s properties and set the
participant’s success score for each task.

View the results on the Graph tab, Success Score.

feelings about a product before,
during, and/or after a test.

Learnability A task is repeated at least once to | Note each participant’'s performance on the same or
determine whether the time on very similar tasks.
task is shorter, fewer errors are On the Graph tab, choose Time on Task, Errors
made, or the task is more and/or Task Success and limit your results to the
successful. tasks that are similar.
Look for trends such as lower time on task, fewer
mistakes and greater success.
Satisfaction Enumerates participants’ overall Initial impression surveys, task exit surveys, the

Satisfaction Usability Scale Survey (SUS) make be
included with each configuration, and administered
before the test, after each task or following the entire
test.

Set these up in your configuration before the test.

Mouse Clicks

Measures the number of clicks
that a participant enters.

View the results on the graph tab by choosing Input
Device Analysis.

Part of the Rich Recording Technology™ data already
captured in your recording.

Issue Counts

categorizes problems observed.

Mouse Measures the distance the mouse | View the results on the graph tab by choosing Input
Movement travels. Device Analysis.
Part of the Rich Recording Technology™ data already
captured in your recording.
Problem/ Records, counts, ranks, and/or Set up one or more markers to note problems in your

recording configuration. You may wish to include a
severity scale. Ask observers to make note when a
problem is observed.

To view result, search for those markers on the
Analysis tab. Export them to spreadsheet for use with
findings.
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Name What was Measured How To Retrieve the Measure in Morae

Optimal Path Observes the path a participant Make a recording of someone taking the “optimal
takes to accomplish a task and path” as one of your “participants.”
compares it to a predefined On the Analysis tab, view Windows/Dialog Events or
optimal path. Web Page Changes for each recording, ordered by

participant. Compare each test participant to the
optimal. Look for trends and common places where
participants wandered “off the path.”

Make Your Own | With Rich Recording Technology Search for events, create markers or analyze the data
™ data, you can design the study | you need. Customized Graphs can be created to meet
that fits your needs your specification.
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Appendix A: User Research Request

Collect the following information to use as the base of a usability test.

Iltem Description Examples

Background

Introduce the product and
give background on why you
want to gather user
feedback.

The product team is looking to gain insight into how
users interact with the company web site. We’'d like to
learn more about user’s expectations for the site and
how they find what they’ve looking for, i.e. search
engine, web site search, browsing, etc.

When originally creating the company web site, it was
meant to contain mainly contact information and
product documentation. Now that we’ve moved on to
provide additional resources, downloads, tutorial
videos, and more, we’re not sure that the format of the
site is appropriate.

Participants

Desired qualities of
participants.

We’d prefer participants with no or little experience
with the TechSmith web site, but they should be
comfortable using the internet.

Usability What you hope to learn with Before we redesign our web site, we’d like to learn

Goals this test. more about how our users interact with the currently
available materials. By learning about our users, we
will be able to make informed design decisions.

Key Points | What kinds of actions or The tasks should cover working with the web site in a
features the test tasks should | couple of different ways. The tasks should help
cover. answer the following questions:

Also may include a list of the | B Can users easily find the web site?
questions the team wants the | »  Can users find a specific item on the site?
usability test to answer.
B Can users successfully download an accessory
for a product?
B  Can the users find and use the blog?
Timeline The timeline for testing: The web site is available for testing at the current
» When the product will be | time. The team would like the results back to us by the
ready for testing end of this quarter, as we will start design next
= When the team would quarter.
like to discuss the results
B Any other constraints.
Additional Anything else that needs to The whole product team will be out for a conference
Information | be taken into consideration. from February 1 through February 5. Since we would

like everyone to observe each test, please do not
schedule testing for these dates.
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Appendix B: Example Protocol

(Name of Project)
Protocol

Facilitator Script, Data-Collection Sheets, and Participant Forms

For (Product), ABC Corporation

[Version 1|Date]
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(Product Project)Protocol

This document is the observation protocol for the (Name of Project), which ABC Corporation will conduct with
up to 10 participants throughout Southeast and Mid-Michigan. This document contains all the materials
needed for the observation sessions, including the session set-up checklist, the facilitator’s script, data-
collection sheets, and participant forms.

Session Set-Up Checklist

Before a session begins, the usability team performs all set-up tasks for the session as follows:

Computer v

Start computer

Set up camera

Open Morae Recorder

Check camera angle

Do test recording

Verify sound and video in test recording

Clear cache or data in program

Participant Paperwork

Release and Non-disclosure agreement

Background Questionnaire

Session Instructions and tasks

Additional Points
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Facilitator Tips

Usability testing is conducted in a way that solicits the user’s thinking and feelings without interfering with his
or her own discovery process. No judgment should be apparent to the user about the user’s activities, and no
direct help is usually offered.

If the user appears stumped, a prompt such as “Do you see anything on this screen that will help you?” may
be asked, but normally, the user will not be told exactly how to succeed, unless that has been scripted into
the protocol for a specific purpose. Failure is an appropriate outcome for some tasks. A debrief on thoughts,
problems points, and observations from the test are usually conducted.

Observers logging for the test administrator will want to capture start and stop times, significant statements,
errors and problems, and other noteworthy events. Accuracy is not critical — but timeliness can be. Capturing
as many observations as appropriate is preferable to perfect grammar while logging.

User observation is usually conducted in a free form. Chat with participants until they forget they are being
recorded.

Questions should generally be limited and open-ended questions such as ‘I noticed that you have a post-it
note to remind you of XXXX. Can you tell me why? Can you tell me about a time when you needed to
remember this item but had trouble?” Diplomacy and tact are absolute requirements.

Observers want to make sure those activities, comments, and surroundings are captured. Tasks may be
timed from start to finish. This would be especially helpful for repetitive tasks, but any process that might take
time would be worth capturing. Try to be unobtrusive as they work, even at the expense of capturing data.
Notes can be taken later — this is qualitative data, not quantitative.
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Introduction/Facilitator Script

The purpose of the Introduction is to help participants feel comfortable with the observation process in general
and to explain their role in helping to improve the usability of (the Product) in particular.

Start Time:

Begin the session by saying:

Thank you, [name], for agreeing to participate in this user study. My name is [name], and I'll be working with
you today. In this study, we're exploring how people who use our products like to work. We’d like to talk with
you and watch you perform the tasks that you perform in the course of your work every day. We may ask you
some questions while you work.

I will try to be as unnoticed as | can sometimes, and at other times, | might ask
you about what you are doing, to help me understand your work patterns better.

Administer Questionnaire and Non-disclosure

Okay, let’s talk about how we would like to work with you this session. I'd like to position myself here, and
record your activity on the computer. | may also make the notations in my notebook as well.

I’'m going to give you this series of (number) tasks to perform, with a scenario to explain why you are doing
these tasks. As you work, feel free to perform whatever tasks you think are appropriate, whether they are
related to our products, to computers, or not. | can try to provide anything you might feel is missing. What I'd
like you to do, though, is to talk out loud about the things that you are thinking, doing, feeling and expecting.

You are free to ask me any questions. However, depending on the type of study we are doing, | may or may
not answer you, or | may answer with another question.

Please feel free to talk about anything you encounter, especially any problems you have during the tasks. |
am not the developer of these products —I'm part of an objective evaluation team—so you can feel free to
give me your candid opinions. You won’t hurt anyone’s feelings. Your comments are important, which is why
we’ll be taking notes and videotaping the session, which also gives us a record of what you’re looking at. I'd
like to remind you at this time that your name will not be used in our report, and that all information you
provide today will be reported anonymously.

I want you to know that you are free to stop or take a break at any time, and that will not affect the
consideration we will be providing. Please let me know if you need anything to make yourself more
comfortable.

Do you have any questions for me?
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Participant Paperwork

This page is a cover sheet for all session data pertaining to this participant. Store each participant’s session
data in his or her own folder or envelope and labels each page of notes and forms with the participant’s
number.

Participant #:

Session: (date/time)

Pre-session Paperwork

Before testing begins, the participant fills out the following forms:

# Understanding Your Participation (Video release/authorization)
Permits recording the session. If permission is denied, you may still conduct the session and use the
participant’s data in reporting results. If it includes a non-disclosure agreement, the participant is required
to keep session and web site/product information confidential.

B Background Questionnaire (to verify screened-for participant characteristics and to provide a
background and usage context in which to interpret t data)

Once setup is complete and all forms are filled out, the facilitator begins with the introduction.

The facilitator will hand the forms on the following pages to the participant at the appropriate times during the
test session.
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Understanding Your Participation

Please read this page carefully.

ABC Corporation is asking you to participate in a (Type of Study) study. By participating in this evaluation,
you help us improve our products.

We will observe you and record information about how you work. We may record your comments and actions
using written records, recorders and video cameras.

By signing this form, you give your permission for ABC Corporation to use:

B recorded voice (if you consent to this, initial here )
B verbal statements (if you consent to this, initial here )
B  session recording (if you consent to this, initial here )

This data will be used solely for the purposes of product design and development. Your full name will not be
used during any presentation of the results of this study.

Any information you acquire about our products is confidential and proprietary and is being disclosed to you
only so you may participate. By signing this form, you agree not to talk about this product to anyone. You may
tell them that you helped to evaluate an Internet web site.

You may withdraw from the evaluation at any time. If, at any time, you need a break, please inform the
observer immediately. If you have questions, you may ask at any time.

If you agree with these terms, please indicate your agreement by signing below.

Name (Printed)
Address

Signature
Date
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Background Survey Page 1

Please take a few minutes to answer the following questions to help us better understand your use of
computers and the Internet. No information from this survey will be linked to you in any way.

Participant:

Computer Use

1. What type of computer do you use?
At home: UuPC UMac
At work: UuPC UMac

2. About how many hours a week do you use a computer?
At home:
At work:

3. What do you typically use your computer for?

UGames and pleasure UGraphics
QAccounting/Finance UData storage (i.e., databases)
WUEmail or chat Qinternet

UWord Processing UOther

Internet Use

1. How long have you been using the Internet?
2. Which Internet browser or browsers do you use?

Browser # Years Used # Months Used

Internet Explorer
Mozilla Firefox
Other:

Other:
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Background Survey Page 2

Participant:

3. How would you rate your experience and proficiency using the Internet?
Poor Average Excellent
1 2 3 4 5

4. What do you usually do on the Internet

O surfing O selling
a  email O site development
O chat O interactive games
O information gathering 0 MP3 downloading
O  buying a Other

5. Have you ever made any online purchases?
a No

O Yes How often?

What have you purchased?

What problems, if any, do you encounter most often when purchasing online?

6. How often do you use the (Product)?
O Never

Once or twice
Once a year

Once a month

00000

At least once a week

(Study Name)
Usability Study

Participant ID:

Test Date/time:
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Caution

V' This is the administrator's version of the usability test. This version includes the success path for
each task. Not to be given to the user before the usability session.

(Remove this information and the success paths prior to giving the test to a participant.)

Test Scenario/Session Instructions

You will be performing up to different tasks using
<<Provide needed information about the scenario: role, location, etc.>>

Instructions for each task are given in the shaded text boxes.
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Task 1.
Task 1 instructions here.

Tip: Ask an easy question for early success.

Task 1 Success Path.

Provide an answer for the facilitator version only. Remove from the participant version.
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Task 2.
Task 2 instructions here.

Task 2 Success Path.

Provide an answer for the facilitator version only. Remove from the participant version.
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Task 3.
Task 1 instructions here.

Tip: Ask an easy question for early success.

Task 3 Success Path.

Provide an answer for the facilitator version only. Remove from the participant version.
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Thank you for participating in the study!

Debrief Topics

List topics here that will be relevant to understanding, including problems, errors, events and quotes. In an
A/B test, show the alternative and solicit feedback, if appropriate. Ask nonjudgmental, open ended questions,
such as, “I noticed that you did x? Can you tell me about what you might have expected?”
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Appendix C: Example Report
[Product Name)]

[Company Name]}
[Usability Study
Type]

Date

User Experience Project Contributors
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Executive Summary

Summarize points of report here:

>

b
b
b

Summary of Performance Results

Name and describe the product
Summary of method(s) including number and type of participants and tasks
Results expressed as mean scores or other suitable measures of central tendency

Reason for and nature of the test

Participant 1

User #

Measure 1

Measure 2

Participant 2
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Methodology

Objectives (Or Research Goals)

[This evaluation was designed to answer the following questions:

B List usability questions here
3

B  More stuff on research goals...]

Product

[Information on product; version; if pre-release which build; if prototype then details on mode of prototype
(low-fi/paper, wireframe; hi-fi/flash); if web product then similar information including URLS; etc.]

Participant Profile

[How patrticipants were recruited. Compensation/considerations offered.
Total number of participants. User types (e.g. experienced and inexperienced) and number of, etc.

Participant information, e.g. profession, interest or motivation for product use, and information from
demographic/background questionnaire.

Include links to (in network drives or locations in this document as appendices) background questionnaire,
tables of results from questionnaire, and participant screener or recruitment communication materials, if
necessary. |

Characteristic 1 Characteristic 2 Characteristic N

Participant 1

Participant 2

Participant N

Research Design

Timeline

[Information on when the tests took place.]

Research Component Dates

Recruiting [Date] — [Date]
Test planning and design [Date] — [Date]
Conducting research [Date] — [Date]
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Analysis [Date] — [Date]

Results Presentation [Date] — [Date]

Research Environment

Where tested.

Information on lab, remote, or off-site area, equipment, event (if applicable), recording methods used, etc.

Test Design

[Information on type and length of test (e.g. “One-on-one sessions lasted an hour for each participant, and
included:”

Informed consent form for participation — Participants were asked to sign a consent form before they
participated.

Background guestionnaire — We administered a brief questionnaire to gather background information on
participant work, technology, and product experience.

Verbal overview of study — Participants were given a description of the general nature of the study and
advised on how best to perform during the test.

Research performance — Participants were asked to perform several tasks using the product. The tasks were
in the context of doing x activity to provide a realistic context for testing. Participants were asked to think
aloud and describe any confusion while performing tasks. This was used to identify areas of difficulty, as well
as usage patterns and types of participant errors.

Post-study debriefing -- Participants were debriefed at the end of the session on certain areas of their
performance or to give further feedback.

Post-study questionnaire — A post-study questionnaire was administered to obtain satisfaction ratings.

Include links to (in network drives or locations in this document as appendices) to test protocol document (and
prototype files, if applicable).]
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Results

Constraints

Information about constraints.

Metrics

[Key usability goals included effectiveness, which refers to how well a system does what it is supposed to do;
efficiency, or the way a system supports users in carrying out their tasks; and satisfaction, which relates to the
subjective responses users have to the system.

Effectiveness is typically exhibited by task success, efficiency by time on task, and satisfaction is typically
measured with a scale.

The guantitative measures included:

B Time on task
#  Error rate
B Success score (or task success)

The qualitative measures included:

B participant satisfaction ratings (post-study questionnaire)
# verbal feedback during and after the session]

Time on Task

Insert graphs and table of data.

Error Rate

Insert graphs and table of data.

Success Score

Insert graphs and table of data.

Satisfaction Ratings

Insert graphs and table of data.
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Usability Issues and Recommendations

Usability Issue Recommendation ‘ Severity
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Conclusion and Next Steps

[Information/recommendations to team on how to proceed with recommendations and suggestions on further
research/design work to be done.]

Page 54



Appendix

[Put Possible Appendices to Related Docs Here]
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Appendix D: Usability Test Checklist

The purpose of this checklist is to identify the activities required for planning and executing a successful
usability test.

1. Meet with Stakeholders to Conduct an Initial
Interview

O Review the system to be tested
O Document concerns and define problem statements
0 Determine acceptable usability goals and purpose
Use these to determine your “Key Evaluation Measures”
O Review user profiles or types of users
O Determine a preliminary test date
O Document:
o Intent of the test
Overall methodology planned
Business objectives and goals
Usability goals
Users and user groups to be tested

o O O O

2. Recruit Participants

O Document the number of participants in each user group to be tested
O Develop a testing schedule based on preferred times and dates
O Develop a screener to vet participant qualifications according to user group
O Use any resources to contact users:
o Internal or customer databases
o E-mail contacts
o Newsletter, product, or web site posts
o Professional recruiting agencies
o News, web site, or social-networking service ads
O Schedule participants
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3. Plan the Test

a
a
Q

Q

a

a

Design test scenario and task list
Determine key evaluation measures
Create a usability test protocol containing:
o Anticipated machine set up (lab, off-site, etc.)
Checklist for setting up and facilitating each test session
Introduction script
Non-disclosure and recording agreements
Background questionnaire
Tasks (including success criteria, participant test booklets, etc., if needed)
Debrief questions
o Post-task or post-test satisfaction surveys, if needed
Schedule any facilities or space required for lab setup, observation, or participant debrief/greeting
Load the necessary software and data needed to conduct the test

Confirm test dates and time with participants, including location, maps or directions, and contact
information

Create a folder for each participant containing all participant paperwork included in the test protocol
Prepare “thank you” notes and considerations for participants

Invite executives, managers, development team members, marketing staff, and other stakeholders to
observe the tests

O O O O O O

4. Run-through the Test

Q
a
Q
Q

Install final software and/or prototypes and configure the test machine

Review test objectives, metric measures, and areas of concern with observers
Run a pilot usability test, including recording

Revise test materials as needed based on pilot test
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Conduct the Test

Power up lab machine, check cameras and microphones

Send connection information (e.g. IP address) for using Morae Observer to stakeholders and observers
Check availability of refreshments for participants

Greet your participant at test site as scheduled

Ensure participant comfort (e.g., temperature, seating, etc.)

Have the participant fill out the non-disclosure/recording agreement and any background questionnaires
(if not using Morae to deliver surveys and questionnaires)

Start the Morae recording

Review the test procedure with the participant (using the Introduction script)

Use best practices for facilitation

Debrief participant after test (including post-test questionnaire and any questions)

End Morae recording

Thank the participant, give any considerations for participation, and walk participant out

Reset your test or lab machine, clear data, and save participant activity as appropriate following each test
session

Collect all test materials, save recording file, review with observers as time permits, and store notes and
materials in folder; debrief with stakeholders and observers periodically

Repeat these steps for each participant test session

Analyze the Test

Using Morae Manager, review your test and conduct analysis on key evaluation measures
Make highlights video clips of interesting moments

Document findings and recommendations (collaborate with development and stakeholders)
Create a presentation or report

Present findings and highlights tape to stakeholders

Next Steps

Send thank you notes and considerations to participants (if not already done)
Determine “lessons learned” and communicate to peer group

Finalize project portfolios, organize and/or archive recordings, and store materials for later reference
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